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CHAPTER 1

Introduction
Moving from Adobe FrameMaker to Flare is easy, although to get the best results you need to do
some planning before you start. The following topics provide suggestions for a better experience.
n

About Flare and FrameMaker Consider the fundamental differences between Flare and
FrameMaker. Then analyze your FrameMaker files in order to make the import process as
clean as possible. See "About Flare and FrameMaker" on page 7.

n

Before You Import Take time to prepare your FrameMaker files before you import them into
Flare. See "Before You Import" on page 8.

n

As You Import Use these tips as you work through the import process to make sure the experience is a smooth one. See "As You Import" on page 28.

n

Import Process Follow these steps to import your FrameMaker files. See "Importing
FrameMaker Files" on page 44.

n

After You Import Once you're finished importing, there are some additional tasks you'll need to
perform. See "After You Import" on page 62.

n

FAQs Take a look at these frequently asked questions for further information about the import
process. See "FAQs for FrameMaker Users" on page 68.

NOTE: Some of these topics refer to plug-ins and tools from other vendors to help you
clean up your FrameMaker files. MadCap Software is not associated with the companies or
individuals who make these tools. You do not need to purchase any of these tools to clean
up your FrameMaker files; they can just make it easier and faster. Many of the listed tools
run in a Shareware mode.
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CHAPTER 2

About Flare and FrameMaker
Flare is different than Adobe FrameMaker, not just because it's a different product, but because
Flare thinks about content differently than FrameMaker.
In FrameMaker, you use a book with files to define your content. The smallest chunk of information
is typically the file, or chapter. You assemble a group of files into a book, which is your deliverable.
You can use Flare the same way, in that you can open a topic and write a 50-page Chapter 4, but the
real power of Flare will be missed.
In Flare, you don't work initially with chapters; rather, you work with topics. Similar to FrameMaker,
you assemble the topics into the deliverable, but you will have many more topics than you had
chapters in FrameMaker.
Topics are the unit of content that you should be working with in Flare. They are usually 2 to 4 pages
of text, including any graphics. In most cases, topics will probably map to the headings (Heading 1,
Heading 2, and so on) in your FrameMaker files.
Not all the information in every heading section should be a topic, though. For example, the information in your heading level 4s may not be able to stand on their own—this information may need the
context of the information in the heading level 3 above it to make sense to the reader.
There are no hard and fast rules about the size of the chunks of information and how to break it up.
In general, a topic should be able to stand on its own. This is where knowing the structure of your
FrameMaker files is going to help you a lot.
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CHAPTER 3

Before You Import
The import process will require less work overall if you prepare your files before you start. Just to be
safe, make a backup of all FrameMaker files first.
This chapter discusses the following:
Special Markers

9

Cleanly Formatted FrameMaker Files with No Style Overrides

10

Logically Structured FrameMaker Files

13

Consistently Use and Apply Paragraph, Character, and Table
Formats

14

All Cross-References and Referenced Files Need Targets

15

Update TOCs

15

Distiller Settings for Importing Graphics

16

Creating Drop-Down Effects in FrameMaker Source Documents

18

Creating Hyperlinks in FrameMaker Source Documents

20

Creating Passthrough Markers in FrameMaker Source Documents 21

CHAPTER 3

Creating Topic Alias Markers in FrameMaker for CSH

24

Specifying Custom File Names for FrameMaker Imports

26
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Special Markers
If you are used to importing your FrameMaker documents into Quadralay WebWorks, you may have
used special markers in FrameMaker when doing so. You can continue doing the same for importing into Flare. All special markers supported by WebWorks are also supported by Flare. The following
are some of the more common types of markers.
n

Filename This marker lets you control the file names given to the new topics that are created
from the imported documents. It is highly recommended that you use this marker. See "Specifying Custom File Names for FrameMaker Imports" on page 26.
EXAMPLE
Let's say that you have a place in a FrameMaker document that is using the
Heading 1 style and contains the text "All About Rabbits." You want a new topic to
be created at that point when you import the document. However, you also want
to make sure that the file name for that new topic is simply "Rabbits." Therefore,
you open the FrameMaker document and insert a filename marker at that heading, using the text "Rabbits" for the marker.
When you import the FrameMaker document, you select to split new topics on
certain styles, including the Heading 1 style. After the import is finished, one of
the topics created is named "Rabbits.htm."

n

Hyperlink If you are importing Adobe FrameMaker documents and you have created hyperlinks by using "Specify Named Destination" and "Jump to Named Destination" markers, Flare
will automatically convert them to links in your project. See "Creating Hyperlinks in
FrameMaker Source Documents" on page 20.

n

Topic Alias A topic alias marker is a special marker that you can insert into your FrameMaker
source content wherever you want a new context-sensitive Help (CSH) identifier to be created in Flare (after you import the FrameMaker document). After the developer "hooks" the
CSH identifier with the appropriate user interface element in the application, that imported
FrameMaker content will display when a user opens the CSH in the application's user
interface. See "Creating Topic Alias Markers in FrameMaker for CSH" on page 24.
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Cleanly Formatted FrameMaker Files with
No Style Overrides
The more your FrameMaker files consistently use defined styles, the more smoothly the import process will be. Use character, paragraph, and table formats consistently and with no manual overrides.

Character Tags
If you hand-bolded text throughout your book, but the bold isn't a character style, it may be worth
your while to create a Bold character style and apply it to all instances of hand-bolded text.

Paragraph Tags—Numbered Lists
FrameMaker requires you to create two distinct paragraph tags to handle numbered lists. Because
Flare uses standard HTML code for ordered lists and list items, content developers frequently
choose not to take the extra steps to create distinct paragraph styles to handle list numbering.
Because FrameMaker handles list numbering using paragraph tags, Flare converts those tags to the
to the standard p style during the import. You then apply the desired ordered list and list item tags to
the existing numbered steps in Flare.
EXAMPLE
In FrameMaker, you must create two distinct paragraph tags to handle automatic list
numbering—one tag to apply to the first step in the list and another tag to apply to the
remaining steps.
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Because Flare uses standard HTML code (where an ordered list starts with the <ol> tag
and each list item starts with the <li> tag), there is no need to create distinct paragraph
styles to handle list numbering. You simply apply the desired numbered list format
using the quick list drop-down menu shown below.

Once the list numbering is set, you don't need worry about it again. The example below
shows you a simple numbered list in the Flare XML Editor:
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The Flare Text Editor lets you see how ordered lists and list items are formatted in
HTML:

If you want to map numbered lists from FrameMaker to a paragraph style in Flare, the option is available. Before importing your FrameMaker document into Flare, create comparable p styles in the
Flare stylesheet and ensure that those styles are set to use the appropriate mc-auto-number-format
command.
Create This Style in
Flare

mc-auto-numberformat

To Map It to This FrameMaker Paragraph
Tag

p.Step1

{n=1}

Step1 (or your equivalent)

p.StepNext

{n+}

StepNext (or your equivalent)

The next step is to import your FrameMaker document into Flare. During the import process, you
can map your FrameMaker paragraph tags to the corresponding tags in Flare.
NOTE: The import process does not support mapping numbered lists from FrameMaker to
CSS list item li styles.
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Logically Structured FrameMaker Files
The more logically you structure the information in your FrameMaker files, the easier the information will be to work with in Flare.
EXAMPLE
The information tagged Heading 1 should all share the same kind of information.
Let's say you have the following:
H1: Opening Files
H3: Editing Files
H2: Saving Files
H4: Printing Files
H3: Archiving Files
These are probably all first-level headings and should be moved to be at the same level.
You can do this in FrameMaker or you can use an outlining FrameMaker utility called
Enhance, available at http://www.sandybrook.com.
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Consistently Use and Apply Paragraph,
Character, and Table Formats
Over time, it's easy for FrameMaker files to include many formats, some used and some not. It's
also easy to have several formats that look identical and serve the same purpose. This can cause
confusion after importing into Flare.
You should delete the unused formats in your FrameMaker files. You can do this manually, or use
tools like the following to help.
To Delete

Use This Tool

Available From

Unused Character
Formats

Character Tools

http://www.siliconprairiesoftware.com/

Unused Paragraph
Formats

Paragraph Tools

http://www.siliconprairiesoftware.com/

Unused Table
Formats

Table Tools

http://www.siliconprairiesoftware.com/

Make sure you understand how your files were designed. It's possible that you or someone else
tagged different kinds of information with tags that look identical. You may not want to undo this.
If you have a lot of identical formats in your FrameMaker files and they serve no purpose, you should
consolidate these.
To help you identify identical tags, it might be useful to list all tag settings. Table tools, Character
Tools, and Paragraph Tools, listed above, will create these lists.
After you identify the formats you want to change, you can go to the following website and get
FindChangeSpecial:
http://www.frameexpert.com/plugins/findchangespecial/index.htm
You can find and change format names in FrameMaker, so this tool is not essential, but it makes the
process faster.
After the import process, you may still need to clean up the formats in Flare. If so, you should utilize
Flare's analysis tool. It can show you unused styles, identical styles, and other issues in your
stylesheets. You can delete, rename, and modify your imported files based on the analysis.
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All Cross-References and Referenced Files
Need Targets
To import your files, Flare (and FrameMaker) should be able to find all the files used. In
FrameMaker, this is pretty easy—generate/update your book so it finds all the files the book. Even if
you're only going to import one file from a book, this lets FrameMaker know where everything is and
how to find it.
If FrameMaker reports it cannot find files or cross-references, sort this out before you start your
import in Flare.

Update TOCs
If you are importing a book file that has a book-level table of contents (TOC), the TOC is used to create a Flare TOC. This saves you a lot of time and effort in re-creating your FrameMaker TOC.
Before you start the import in Flare, make sure the FrameMaker book-level TOC includes the headings you want in the eventual Flare TOC. After you import into Flare, you can add topics to the Flare
TOC, but making sure the FrameMaker TOC is correct saves you work after the import.
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Distiller Settings for Importing Graphics
Selecting the right import options in Flare is half the process in getting graphics that look good. The
other half is selecting the correct Adobe Distiller options.
Why the correct Distiller options? Because Flare uses Distiller to convert graphics from
FrameMaker. This ensures the best quality graphics when you import into Flare. Therefore, it’s
important to get the settings right in Distiller before you start the import process.
Open Distiller on your computer, find the Images settings, and set all Downsampling to Off or None.
This prevents the Distiller from reducing the number of pixels in your graphics, making the resulting
graphic look much cleaner. The following example shows Distiller 8 but the same settings can be
found in other versions of Distiller. For more information about Distiller, please refer to its documentation.
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When you’re done, save the Distiller settings as a .joboptions file. When you return to the Distiller
interface, make sure you select the .joboption file that you just created.

When you close Distiller, it automatically uses the settings last selected when it was closed. So
make sure you select the .joboption file that you created before you close it.
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Creating Drop-Down Effects in FrameMaker
Source Documents
The following steps show you how to create a new drop-down effect in a FrameMaker source document (if you plan to import that document into Flare). After you import the document, the dropdown effect will automatically be created in the XML Editor.

HOW TO CREATE A DROP-DOWN EFFECT IN A FRAMEMAKER SOURCE DOCUMENT
The following steps may vary in different versions of FrameMaker.
1. Open the FrameMaker document.
2. In FrameMaker, create the two drop-down paragraph styles that are required for producing
this effect. This is a one-time step in the document. Afterwards, you can simply select the
newly created styles when specifying drop-down text. To create the two styles, do the following.
a. In FrameMaker, select Format > Paragraphs > Designer. The Paragraph Designer opens.
b. From the Commands field, click the down arrow and select New Format. The New
Format dialog opens.
c. In the Tag field, type PullDownButton.
d. Make sure that the Store in Catalog check box has a check mark.
e. Make sure that the Apply to Selection check box does NOT have a check mark in it
(unless you want the style to immediately be applied to the paragraph where your cursor
is placed).
f. Click Create.
g. Follow these same steps to create a paragraph style called PullDownBody.
h. Close the Paragraph Designer.
3. In the FrameMaker document, place your cursor in the paragraph that you want to serve as
the drop-down hotspot in the online output (i.e., when the user clicks that hotspot, the text
below that is identified as the drop-down body will be shown or hidden).
4. From the styles drop-down menu or from the paragraph catalog, select PullDownButton.
5. Highlight the paragraph(s) that you want to serve as the drop-down body in the online output.
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6. From the styles drop-down menu or from the paragraph catalog, select PullDownBody.
7. Save the FrameMaker document.
After you apply the drop-down styles to the FrameMaker document(s), you can import those documents into a Flare project.
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Creating Hyperlinks in FrameMaker Source
Documents
If you are importing Adobe FrameMaker documents and you have created hyperlinks by using "Specify Named Destination" and "Jump to Named Destination" markers, Flare will automatically convert
them to links in your project. Following are steps for creating these hyperlinks in Adobe
FrameMaker. For more information, please refer to the documentation provided with Adobe
FrameMaker.

HOW TO CREATE A HYPERLINK IN A FRAMEMAKER SOURCE DOCUMENT
The following steps may vary in different versions of FrameMaker.
1. Open the Adobe FrameMaker document.
2. In Adobe FrameMaker, place your cursor at the spot to be used as the destination for a link.
This might be a heading that will become a new topic when you import the document. When a
user clicks on the hyperlink (created below), this is the content that will be displayed to end
users.
3. Select Special > Hypertext. The Hypertext dialog opens.
4. From the Command field, select Specify Named Destination.The text "newlink" is added to the
area below.
5. After the text "newlink," type a name to identify the destination (perhaps the name of the heading).
6. Click New Hypertext Marker.
7. Locate the area that you want to serve as the hyperlink. Prepare the area to become a hyperlink, according to the documentation provided with Adobe FrameMaker.
8. Place your cursor in the prepared hypertext area.
9. From the Command field of the Hypertext dialog, select Jump to Named Destination. The text
"gotolink" is added to the text area below.
10. After the text "gotolink," type the name that you gave to the destination marker.
11. Click New Hypertext Marker.
12. Close the Hypertext dialog.
13. Save the Adobe FrameMaker document.
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Creating Passthrough Markers in
FrameMaker Source Documents
A passthrough marker is a special marker that you can insert into your FrameMaker source content
when you have information or code that you plan to import to Flare and want left alone (or "passed
through," leaving it exactly as you have authored it, rather than processing it). A passthrough marker
can be just about anything, as long as supports it in the XHTML code.
You can specify how the marker content should be treated when the FrameMaker document is
imported. The first option is that you can import the marker content as regular text (which is the
default setting). The second option is that you can import the marker content as an XML fragment
(e.g., the first part of a bold tag—<b>—but not the second part). The third option is that you can
import the marker content as a complete XML tag.
You might use a passthrough marker for various reasons, such as for importing a marker as XHTML
or JavaScript code.

EXAMPLE
Let's say you plan to import some FrameMaker documents to Flare and you have locations in those documents where you want to link to CHM files. The problem is that
FrameMaker does not allow you to create links to CHM files in such a way that those
links can then be imported into another software application.
Therefore, you create a passthrough marker in the FrameMaker document, providing
the beginning "href" tag and path to the CHM file. Like this:
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Then you create a second passthrough marker, providing the end tag for the link. Like
this:

When you import the FrameMaker document(s), you can specify that the passthrough
markers should be imported as XML fragments. In Flare, the link to the CHM file will
look and work as it should.

HOW TO CREATE A PASSTHROUGH MARKER IN A FRAMEMAKER SOURCE DOCUMENT
Following are steps for creating these markers inAdobe FrameMaker. For more information, please
refer to the documentation provided with Adobe FrameMaker.
The following steps may vary in different versions of FrameMaker.
1. Open the FrameMaker document.
2. In FrameMaker, create the passthrough marker type that is required for this feature. This is a
one-time step in the document. Afterwards, you can simply select the newly created marker
type when applying it to content. To create the passthrough marker type, do the following.
a. In FrameMaker, select Special > Marker. The Marker dialog opens.
b. From the Marker Type field, click the down arrow and select Edit. The Edit Custom
Marker Type dialog opens.
c. In the field, replace the existing text and type PassThrough.
d. Click Add.
e. Click Done.
3. In the FrameMaker document, place your cursor at the location where you want to insert a
passthrough marker.
4. If it is not already displayed, open the Marker dialog (Special > Marker).
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5. If the passthrough marker type is not already displayed in the dialog, click the Marker Type
down arrow and select PassThrough.
6. In the Marker Text field, enter the text and/or code that you want to be included in the
marker.
7. Click New Marker.
8. Save the FrameMaker document.
9. In Flare, go through the process for importing the FrameMaker document. When you arrive at
the "Options" page in the Import FrameMaker Wizard or the "Options" tab in the Frame Import
Editor, make sure Enable 'Passthrough' Markers is selected. Then from the Passthrough
Marker Format field, select one of the options:
n

text The marker content will be imported as regular text (default setting).

n

fragment The marker content is imported as an XML fragment (e.g., the first part of a
bold tag—<b>—but not the second part). If you select this option, you will probably need a
second marker in the FrameMaker document to complete the XML tag.

n

xml The marker content is imported as a complete XML tag.
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Creating Topic Alias Markers in FrameMaker
for CSH
A topic alias marker is a special marker that you can insert into your FrameMaker source content
wherever you want a new context-sensitive Help (CSH) identifier to be created in Flare (after you
import the FrameMaker document). After the developer "hooks" the CSH identifier with the appropriate user interface element in the application, that imported FrameMaker content will display
when a user opens the CSH in the application's user interface.
You can use these markers as an alternative to creating the identifiers in Flare.
Following are steps for creating these markers in Adobe FrameMaker. For more information, please
refer to the documentation provided with FrameMaker.

HOW TO CREATE A TOPIC ALIAS MARKER FOR CONTEXT-SENSITIVE HELP
The following steps may vary in different versions of FrameMaker.
1. Open the FrameMaker document.
2. In FrameMaker, create the topic alias marker type that is required for this feature. This is a
one-time step in the document. Afterwards, you can simply select the newly created marker
type when applying it to content. To create the topic alias marker type, do the following:
a. In FrameMaker, select Special > Marker. The Marker dialog opens.
b. From the Marker Type field, click the down arrow and select Edit. The Edit Custom
Marker Type dialog opens.
c. In the field, replace the existing text and type TopicAlias.
d. Click Add.
e. Click Done.
3. In the FrameMaker document, place your cursor at the location where you want to insert a
topic alias marker.
Usually you will place the cursor at the beginning of a heading that you want to be the start of
a new online topic in Flare.
4. If it is not already displayed, open the Marker dialog (Special > Marker).
5. If the topic alias marker type is not already displayed in the dialog, click the Marker Type down
arrow and select TopicAlias.
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6. In the Marker Text field, enter the text to be used as the topic ID.
You might simply type the same text that occurs in the paragraph heading. That way, it will be
easily identified by both you and the developer. When typing the topic ID, make sure you use
underscores between words, because spaces are not allowed (e.g., Properties_Dialog).
7. Click New Marker.
8. Close the Marker dialog.
9. Save the FrameMaker document.
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Specifying Custom File Names for
FrameMaker Imports
If you import Adobe FrameMaker documents, you can split those documents into multiple topics
based on the styles in them. For example, you might decide to create a new topic at each "Heading
1" style in the FrameMaker document. You can also control the file names given to the new topics
that are created from the imported Imported documents. To do this, you need to insert a custom
"Filename" marker at the appropriate headings in the FrameMaker documents where new topics will
be created.

HOW TO SPECIFY CUSTOM FILE NAMES FOR FRAMEMAKER IMPORTS
Following are steps for creating these markers in Adobe FrameMaker. For more information, please
refer to the documentation provided with FrameMaker. The following steps may vary in different
versions of FrameMaker.
1. Open the FrameMaker document.
2. In FrameMaker, create the filename marker type that is required for this feature. This is a
one-time step in the document. Afterwards, you can simply select the newly created marker
type when applying it to content. To create the filename marker type, do the following:
a. In FrameMaker, select Special > Marker. The Marker dialog opens.
b. From the Marker Type field, click the down arrow and select Edit. The Edit Custom
Marker Type dialog opens.
c. In the field, replace the existing text and type Filename.
d. Click Add.
e. Click Done.
3. In the FrameMaker document, place your cursor at the heading where you want to create a
new file during the import.
4. If it is not already displayed, open the Marker dialog (Special > Marker).
5. If the filename marker type is not already displayed in the dialog, click the Marker Type down
arrow and select Filename.
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6. In the Marker Text field, enter the name you want to assign to the file (without the file extension).
EXAMPLE
Let's say that you have a place in a FrameMaker document that is using the
Heading 1 style and contains the text "All About Rabbits." You want a new topic to
be created at that point when you import the document. However, you also want
to make sure that the file name for that new topic is simply "Rabbits." Therefore,
you open the FrameMaker document and insert a filename marker at that heading, using the text "Rabbits" for the marker.
When you import the FrameMaker document, you select to split new topics on
certain styles, including the Heading 1 style. After the import is finished, one of
the topics created is named "Rabbits.htm."
7. Click New Marker.
8. Save the FrameMaker document.
9. In Flare, import the FrameMaker document. When you arrive at the "New Topic Styles" page in
the Import FrameMaker Wizard or the "New Topic Styles" tab in the FrameMaker Import
Editor, select the style(s) where you inserted filename markers in the FrameMaker document.
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CHAPTER 4

As You Import
All of your file preparation is going to pay off in the import process. This section assumes you've followed the best practices in the previous Quick Start topics ("About Flare and FrameMaker" on page
7 and "Before You Import" on page 8). You should have clean FrameMaker files that can locate all
linked files.
When you're ready to import your files, you can do it in two ways:
n

Create a New Project You can create a new Flare project at the same time that you import
your files.

n

Import Files into an Existing Project You can import your files into a Flare project that you've
already created.

See "Importing FrameMaker Files" on page 44.
This chapter discusses the following:

CHAPTER 4

Pay Attention and Be Patient

29

Try It Several Ways

29

Slice Your Information Into Reasonable Chunks

30

Use Special Settings When Importing Graphics

31

Preserve FrameMaker Styles

34
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Map All Your FrameMaker Styles to Those in Your Stylesheet
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Pay Attention and Be Patient
If you rush into opening the Import FrameMaker Wizard, specify a FrameMaker file, and click Finish,
you're likely to hate the results.
The import process requires that you make decisions about what you want, based on what you
have. Because the structure of the information in FrameMaker files can vary wildly, pay attention to
the decisions you're being asked to make and take the time to make them.

Try It Several Ways
Because Flare offers you a lot of options on import, you may be uncertain what you need to select
and why. At the end of the import process, we show you a preview of what your files look like. Take
the time to scroll through the results and look at what happened.
If what you see is not what you wanted, click Cancel and try other options. Rinse and repeat until
what you see in the preview looks like what you want. We provide the preview so you can make an
informed decision about your content before you bring it into Flare. Use that option and don't be
afraid to cancel many times if needed to get what you want.
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Slice Your Information Into Reasonable
Chunks
The New Topics Styles page in the Import FrameMaker Wizard is one of the most important places
to stop and think when you are importing FrameMaker files into Flare.
What you're doing is telling Flare that you want your FrameMaker files chopped into topics, based on
the paragraph formats you move to the right side of the screen. This is where the logically structured documents that you prepared will pay off.
EXAMPLE
In the example below, Flare will make topics out of sections that start with BookTitle,
ChapterTitle, Heading1, and Heading2. No other formats will be used to create topics.

At the end of the import process, carefully review the topics to see if the formats you selected are
the information chunks you want. If they are too large or too small, cancel and select other formats
to see if you like those better.
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Use Special Settings When Importing
Graphics
Technical manuals typically use many graphics. It’s important these come through the conversion
process as clean as possible, and you can use special settings on the Options page of the Import
FrameMaker Wizard to help things along.
When you import, you have a few options for graphics. What you select depends on what you want
to do and how your FrameMaker files are set up. The result also depends on settings in the Adobe
Distiller. See "Distiller Settings for Importing Graphics" on page 16.
n

If your document contains graphics with callouts, you can select one of three options to
determine how the images are imported.
l

l

Generate Images Without Callouts If the anchored frame contains an image along with
callout text, the original image is imported without the callout text. You might select this
option if you have resized the image in FrameMaker. With this option, the imported image
is likely to be of a higher quality than it would be otherwise. You can then add a callout to
the image once it is inside Flare.
Generate Images With Callouts If the anchored frame contains an image along with callout text, Flare creates a PROPS (i.e., properties) file along with the image file when that
document is imported. This means that you can open those image files in MadCap Capture to edit those callouts after the import process is completed.
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EXAMPLE
If you import anchored frame images and tell Flare not to include the callouts, your imported image files will look something like this in Windows
Explorer.

On the other hand, if you import the same images and tell Flare to include
the callouts, it will look something like this in Windows Explorer.

NOTE: Some FrameMaker elements—such as arcs and nested frames—are not
supported with this option.

l

Generate Flattened Images If the anchored frame contains an image along with callout
text, a new flattened image will be created as a result. The callout is included, but you
cannot edit it.
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n

To get the best resolution in the graphics after the import, clear the Preserve Image Size
check box. If you select this option, the original image is imported. However, the <img> tag is
modified in the imported file to closely reflect the height and width of the image in the
FrameMaker document. If you do not select this option, the <img> tag is not modified in the
imported file. Instead, the image is referenced at 100% of its original value. You might then
need to manually resize the image in Flare. But this will give you the cleanest looking graphic
because it wasn’t reduced in size in the import process. For more information about resizing
your graphics in Flare, see the online Help.

Like so many options when you import, review the graphics in the Preview before you commit to the
import. Make sure the graphics look the way you want. If not, click Cancel and change the options.
Also understand that some cleanup may be required, so factor that into your time estimates.
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Preserve FrameMaker Styles
If you have a robustly styled FrameMaker file that you like, and this is your first FrameMaker import,
you probably want to preserve FrameMaker styles on import.
This serves two functions: (1) It makes your Flare documents look very similar to your FrameMaker
documents, and (2) it creates a template that you can easily reuse in future projects. While it may
be some work up front, it results in less work down the line—always a good practice.
NOTE: If you select this import option, you will get a lot of "child" formats in your eventual
stylesheet. The names look like h1.Heading1 or h2.Heading2, where the part after the
period comes from the style names in your FrameMaker files. These formats inherit some
or all of their formatting from the parent (h1, h2, and so on) style.
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Define Your Styles If You are Not Using an
Existing Stylesheet
If you opted to preserve FrameMaker styles, you can edit the styles to look as you want them before
you finish the import. Click the Conversion Styles button if you want to change the formats.
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You do not have to make the changes to the formats here—you can always do it after you import
using the Stylesheet Editor, but it will seem easier to do it now. Your content will come through looking more like you expect.
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Map and Create Cross-Reference Formats
Most technical material includes a lot of cross-references. This is a great practice because it helps
the reader know where related information is in the manual. Flare has a fairly robust cross-reference feature set.
You have two ways of managing cross-references: standard mapping and preservation styles conversion.

Using the Standard Mapping During Import
This is in the Import FrameMaker Wizard, on the Cross-References page. This setting overrides any
other settings you may use. The downside to using this area is that you have little control over the
exact cross-reference structure. It’s best if your cross-references are heading and page style references. You can always change them later.
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Using the Frame Styles Conversion Settings
On the Stylesheet page of the Import FrameMaker Wizard, you can click the Conversion Styles button if you are preserving FrameMaker styles. This opens the Import Styles Editor, which you can use
to change the cross-reference formats in your FrameMaker files, mapping them to exactly what you
want in Flare. This is a better method if you have a lot of unique cross-reference formats, such as
Step # or other references.
When you expand the Cross-Reference node, you see the cross-reference formats in your
FrameMaker document(s). You can specify how these look when they come through the conversion.
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Conversion Table
The following table will help you understand how and what you are converting.
Command

Description

Similar to FrameMaker’s
Format

{b}

Start bold text

Managed in Character
formats

{/b}

End bold text

Managed in Character
formats

{bg}

Start new background color

None

{/bg}

End background color

None

{color}

Start new text color

Managed in Character
formats

{/color}

End text color

Managed in Character
formats

{default}

Reset all font changes

[default]

{ext}

File extension

None

{family}

Start new font family

None

{/family}

End font family

None

{file}

File name, including extension

[fullfilename]

{filename}

File name, without extension

[filename]

{h1}

Text of first heading 1 paragraph in topic

None, although the running header/footer system variable comes close

{h2}

Text of first heading 2 paragraph in topic

None, although the running header/footer system variable comes close
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Command

Similar to FrameMaker’s
Format

Description

{h3}

Text of first heading 3 paragraph in topic

None, although the running header/footer system variable comes close

{h4}

Text of first heading 4 paragraph in topic

None, although the running header/footer system variable comes close

{h5}

Text of first heading 5 paragraph in topic

None, although the running header/footer system variable comes close

{h6}

Text of first heading 6 paragraph in topic

None, although the running header/footer system variable comes close

{i}

Start italic text

Managed in Character
formats

{/i}

End italic text

Managed in Character
formats

{page}

Page number

[pagenumonly]

{pagecount}

Page count

.

{pageref}

Context-sensitive page reference automatically
adjusts from a page number to "above," "below,"
"next," or "previous."

None

{paranum}

The autonumber text of bookmarked paragraph The
bookmark is automatically added to the heading
when you insert the cross-reference.

[paranum]

{paranumonly}

The autonumber only of bookmarked paragraph
The bookmark is automatically added to the heading when you insert the cross-reference.

[paranumonly]
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Command

Description

Similar to FrameMaker’s
Format

{paratext}

Text of bookmarked paragraph The bookmark is
automatically added to the heading when you insert
the cross-reference.

[paratext]

{paraxml}

Text and markup of bookmarked paragraph The
bookmark is automatically added to the heading
when you insert the cross-reference.

None

{path}

File path

None

{size}

Start new font size

Managed in Character
formats

{/size}

End font size

Managed in Character
formats

{sub}

Start subscript text

Managed in Character
formats

{/sub}

End subscript text

Managed in Character
formats

{sup}

Start superscript text

Managed in Character
formats

{/sup}

End superscript text

Managed in Character
formats

{title}

Title of document

None

{u}

Start underlined text

Managed in Character
formats

{/u}

End underlined text

Managed in Character
formats

{url}

File path, URL syntax

None, but HTML marker is
close
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Remember, when you import cross-references, they show the page number from FrameMaker.
Until you put the topics together into a TOC and create a target in Flare, the topics know nothing
about pages and page numbering, except within a single topic.
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Map All Your FrameMaker Styles to Those in
Your Stylesheet
When you reach the import pages for mapping your existing FrameMaker styles to Flare styles,
make sure you map all of them. You can map paragraph styles, character styles, and cross-reference styles.
Unmapped paragraph styles come through as p.whateverthestylenamewas, unmapped character
styles come through as span.whateverthestylenamewas, and unmapped cross-reference styles
come through as MadCap|xref.whateverthenamewas. This may result in lots of formats you did not
actually want in the stylesheet and can take a lot to clean up. It is better to control the mapping up
front and reduce the cleanup afterwards.
EXAMPLE
You might have a paragraph style called "ChapterTitle." When you import this style, you
might want it to be mapped to an h1 style in Flare. Therefore, if you map it to h1, the result will be a style called h1.ChapterTitle. If you do not map it, the result will be a style
called p.ChapterTitle.
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CHAPTER 5

Importing FrameMaker Files
You can import Adobe FrameMaker files in the following ways:
n

Import Into a New Project

n

Import Into an Existing Project (From the Wizard)

n

Import Into an Existing Project (From the Import Editor)
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HOW TO IMPORT FRAMEMAKER FILES
1. Do the following, depending on how you are importing your files:

IMPORT INTO A NEW PROJECT
a. Select Project > Import > FrameMaker Documents.
The Import FrameMaker Documents Wizard opens.
b. Select Import into a new project.
c. In the Project name field, type a name for the new Flare project that will be created
after you perform the import.
d. In the Project folder field, either accept the default location for the new project or click
to find and select a folder.
e. From the Output Type field, select the primary target for your project.

IMPORT INTO AN EXISTING PROJECT (WIZARD)
a. Select Project > Import > FrameMaker Documents.
The Import FrameMaker Documents Wizard opens.
b. Select Import into this project.

IMPORT INTO AN EXISTING PROJECT (IMPORT EDITOR)
Do one of the following:

IF YOU DO NOT YET HAVE A FRAMEMAKER IMPORT FILE
a. Complete the steps for adding an import file.
b. Open the file in the Frame Import Editor.

IF YOU ALREADY HAVE A FRAMEMAKER IMPORT FILE
a. In the Project Organizer, expand the Imports subfolder.
b. Double-click the appropriate import file. The file opens in the Frame Import Editor to the
right.
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2. Do one of the following, depending on the part of the interface you are using:
n

Wizard Click Next.

n

Import Editor Select the Source Files tab.

3. Click

.

4. In the dialog that opens, find and select the files you want to import. You can hold the SHIFT
key to select a range, or you can hold the CTRL key to select individual items. When you are
finished, click Open.
You can select BOOK, FM, or MIF files.
TIP: When possible, it is recommended that you select a Adobe FrameMaker BOOK
file for import and let Flare locate and import all the associated document files within
the Adobe FrameMaker book.
5. You can use the following options as necessary:
This opens the file that is selected in the list.
Link Generated
Files to
Source
Files

This creates a connection between the original files and the files that are created as a result of the import. This is useful if you want to continue editing the
content outside of Flare, instead of editing in the Flare project. Flare recognizes when changes have been made to the source documents and reminds
you to re-import the documents to ensure the Flare project also reflects the
changes. If you use this option, a link icon is added to the top of a linked file in
the Flare interface. This lets you know that you need to edit the source file,
rather than editing this file. If you remove the connection to the source file, this
icon no longer displays on the file. Please note that if you have bound the project to source control, the icons used for source control take precedence over
the link icon.
This removes the selected file(s) from the list.

CHAPTER 5

46

This moves the selected file higher in the list (if you have more than one file to
import). The file at the top is used for the name of the content folder holding
the imported topics in Flare. Also, the order determines how the imported files
are arranged in the Flare TOC that is created as a result.
This moves the selected file lower in the list (if you have more than one file to
import).
6. Do one of the following, depending on the part of the interface you are using:
n

Wizard Click Next. The FrameMaker documents are scanned and the next page of the
wizard opens. The paragraph styles used in the FrameMaker documents are shown on
the left side of the wizard page ("Used FrameMaker Styles").
NOTE: You can skip the rest of the wizard pages by clicking Finish.

n

Import Editor Select the New Topic Styles tab.

7. If you want Flare to split the FrameMaker documents into smaller topics based on any of the
styles shown on the left side of the page ("Used FrameMaker Styles"), double-click that style
to move it to the right side of the page ("New Topic Styles").
EXAMPLE
If you have a style called "Heading 2" in your FrameMaker documents, you might
want new topics to be created whenever Flare finds a Heading 2 style in a document. So you would double-click Heading 2 and move it to the right side of the
page.
8. Do one of the following, depending on the part of the interface you are using:
n

Wizard Click Next.

n

Import Editor Select the Options tab.
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9. You can use the following options as necessary:
n

Add "Topic Continued" links when appropriate Select this option to place a "Topic Continued" link at the bottom of pages when a long topic has been split into multiple ones.

n

Add "Topic Continued From" links when appropriate Select this option to place a "Topic
Continued From" link at the top of continued pages when a long topic has been split into
multiple ones.

n

Cross-Reference Format Use this field to specify the format for the "Topic Continued"
and "Topic Continued From" links. Flare provides a cross-reference format for you—(continued in {title}) or (continued from {title}). With this cross-reference format, the link contains the words "continued in" or "continued from" within parentheses, followed by the
text of the first paragraph in the connected topic. If you do not want the link to use that
particular text, you have a couple of options. First, in Flare, you could manually enter a
heading in each topic that is connected to another topic included in the split. That text
will be used in the link instead (after you update the cross-references in Flare). Another
option is to modify the format by clicking the Edit button.
l

n

Split Long Topics Select this option if you have long sections in your source documents
and want to make sure that they are converted to multiple topics (rather than one very
long topic).
l

n

Edit If you want to modify the cross-reference format provided, click this button,
which opens the Cross-Reference Format dialog.

Threshold Enter the maximum number of characters to be converted to a topic
before a new topic is created. Flare will break the topic at the nearest paragraph to
the threshold value. That way, a new topic will not start in the middle of a sentence
or word, but at the beginning of a paragraph.

Avoid Creating 'Empty' Topics Select this option if you want to ensure that new topics are
not created when large sections are found in the FrameMaker documents without any
content.
l
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n

Anchored Frames With Images You can use this area to specify how Flare should handle
anchored frames that contain images as well as other content (e.g., text callouts).
l

l

Generate Images Without Callouts If the anchored frame contains an image along
with callout text, the original image is imported without the callout text. You might
select this option if you have resized the image in FrameMaker. With this option,
the imported image is likely to be of a higher quality than it would be otherwise. You
can then add a callout to the image once it is inside Flare.
Generate Images With Callouts If the anchored frame contains an image along
with callout text, Flare creates a PROPS (i.e., properties) file along with the image
file when that document is imported. This means that you can open those image
files in MadCap Capture to edit those callouts after the import process is completed.
NOTE: Some FrameMaker elements—such as arcs and nested frames—
are not supported with this option.

l

n

Preserve Image Size This option affects how the size of imported images are handled.
l

l

n

Generate Flattened Images If the anchored frame contains an image along with
callout text, a new flattened image will be created as a result. The callout is
included, but you cannot edit it.

Option Selected The original image is imported. However, the <img> tag is modified
in the imported file to closely reflect the height and width of the image in the
FrameMaker document. This is done regardless of whether you are importing
linked or embedded images from FrameMaker documents.
Option NOT Selected The <img> tag is not modified in the imported file. Instead,
the image is referenced at 100% of its original value.

Auto-reimport before 'Generate Output' This is also known as "Easy Sync." If you created
a connection between your source files and the Flare project earlier in the wizard, you will
likely make future content changes in the source files. When you make such changes,
the source files need to be re-imported into the project so that they can be included in the
output. You have the option of re-importing the files manually. However, you can also tell
Flare to do this for you automatically, so that you do not have to. Select this option if you
want Flare to automatically re-import files when you attempt to build output.
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n

Approximate Filename Length Enter the maximum number of characters to use for naming new topic files that are automatically created after splitting a long topic. The default
is 24.

n

Enable 'Passthrough' Markers Select this check box to include a check mark if you have
created passthrough markers in your FrameMaker source documents.A passthrough
marker is a special marker that you can insert into your FrameMaker source content
when you have information or code that you plan to import to Flare and want left alone
(or "passed through," leaving it exactly as you have authored it, rather than processing it).
A passthrough marker can be just about anything, as long as supports it in the XHTML
code.You can specify how the marker content should be treated when the FrameMaker
document is imported. The first option is that you can import the marker content as regular text (which is the default setting). The second option is that you can import the
marker content as an XML fragment (e.g., the first part of a bold tag—<b>—but not the
second part). The third option is that you can import the marker content as a complete
XML tag. You might use a passthrough marker for various reasons, such as for importing
a marker as XHTML or JavaScript code.
EXAMPLE
Let's say you plan to import some FrameMaker documents to Flare and
you have locations in those documents where you want to link to CHM
files. The problem is that FrameMaker does not allow you to create links to
CHM files in such a way that those links can then be imported into another
software application.
Therefore, you create a passthrough marker in the FrameMaker document, providing the beginning "href" tag and path to the CHM file. Like
this:
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Then you create a second passthrough marker, providing the end tag for
the link. Like this:

When you import the FrameMaker document(s), you can specify that the
passthrough markers should be imported as XML fragments. In Flare, the
link to the CHM file will look and work as it should.
n

Passthrough Marker Format After you enable passthrough markers, click the down arrow
in this field and select the type of format that you want to use for the import.
l

l

l

text The marker content will be imported as regular text (default setting).
fragment The marker content is imported as an XML fragment (e.g., the first part
of a bold tag—<b>—but not the second part). If you select this option, you will probably need a second marker in the FrameMaker document to complete the XML
tag.
xml The marker content is imported as a complete XML tag.

n

Convert equations to MathML Select this option to convert MathFullForm equations (the
FrameMaker-specific format) to MathML (the web standard and Flare format). If you disable this option, equations from FrameMaker are converted to images.

n

Convert Table Styles If you have tables in your FrameMaker documents that you have
formatted in a certain way, select this check box if you want to create matching table
styles as a result of the import. In the Flare project, the new table styles will be named
after the format named applied to the table in FrameMaker (e.g., "Format_A.css,"
"Format_B.css," and so on). You can rename these table stylesheets in Flare after the
import finishes. Even if you do not use this mapping feature, the table formatting still
comes across when you import the documents. The only difference is that table
stylesheets make it easier to maintain the formatting of your tables within Flare.
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n

Reimport Table Styles This option displays only if you are working in the Import Editor,
rather than the wizard. This option is useful after you have already imported FrameMaker
documents and converted the formatting in your tables into at least one table stylesheet
in Flare. You can use this option to determine whether tables should be imported again as
table styles when you re-import. You might want to keep this check box selected for
some re-imports, but other times you might want to deselect it when re-importing.
EXAMPLE
Let’s say you want the formatted tables in your FrameMaker documents to
be converted to table styles when you perform the initial import into a Flare
project. Therefore, in the import wizard, you turn on the "Convert Table
Styles" option. As a result, let's say that Flare creates a new table style and
calls it "FormatA.css."
After the initial import, you realize you want the tables to look a little different. Therefore, in the Flare project, you modify the properties of the
FormatA.css table stylesheet.
Awhile later, let's say you want to re-import the FrameMaker documents.
The problem is that you've already changed the table stylesheet in Flare.
You probably want to keep the tweaked table style so that you don’t have
to modify it again after the import.
This is where the new "re-import" option comes into play. It determines
whether or not a second new table stylesheet will be created, based on the
old look from the tables in the FrameMaker documents.
Here's one scenario. Let's say that before you re-imported the
FrameMaker documents, you selected the "Reimport Table Styles" option
in the Frame Import Editor. And during the import when you were prompted, you selected not to overwrite the existing FormatA.css table
stylesheet. In that case, Flare keeps your tweaked stylesheet in the project, but it also creates another table stylesheet called "FormatA1.css" that
has the old look and feel. All of the re-imported content now links to the
FormatA1.css stylesheet instead of FormatA.css.
Here's a different scenario. Let's say that you perform the same steps
described above, except this time you deselected the "Reimport Table
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Styles" option in the Frame Import Editor. In that case, the second
FormatA1.css file is not created. The imported content is linked to the
FormatA.css table stylesheet that you previously modified, since it already
exists in the project.
10. Do one of the following, depending on the part of the interface you are using:
n

Wizard Click Next.

n

Import Editor Select the Stylesheet tab.

11. Use this page to specify whether the imported topics should be associated with a stylesheet
and/or styles from your FrameMaker files.
n

Stylesheet If you already have a CSS file that you want to associate with the imported
files, click the Stylesheet button. Then navigate to the stylesheet and select it.

n

Preserve FrameMaker Styles This retains any style formatting from your FrameMaker
documents so that you can continue to use that look and feel in Flare. For example, if you
use a style called "Heading 1" in your source documents and that style is blue, it remains
blue after you finish the import to Flare and the new style is created. Also, selecting this
option affects which mapping styles are available as you continue to make your import
selections. If you select this option, you can map the FrameMaker styles to new Flare
styles that keep the name of the FrameMaker style (e.g., Heading 1 becomes h1.Heading
1 in Flare).

n

Don't Preserve FrameMaker Styles This does not keep the style formatting used in the
FrameMaker documents. For example, if you use a style called "Heading 1" in your source
documents and that style is blue, that color (and any other settings for that style) are not
kept after you finish the import to Flare. You will still have styles associated with your content, but it will not look like it did in the source documents. Also, selecting this option
affects which mapping styles are available as you continue to make your import selections. If you select this option, you can map the FrameMaker styles to new Flare styles
that either keep the name of the FrameMaker style (e.g., Heading 1 becomes h1.Heading
1 in Flare) or do not (e.g., Heading 1 becomes h1 in Flare).
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Conversion Styles This opens the Import Styles Editor, which lets you specify how to convert each property of the FrameMaker styles. If you do not enter a property value, the
value from the FrameMaker document is used. If you enter a property value, it overrides
the value from the FrameMaker document. This button is used only if you have selected
"Preserve FrameMaker Styles."

n

EXAMPLE
You might use this button, for example, if you need to change a cross-reference format coming from FrameMaker into something more meaningful
in Flare. There are some cross-reference building blocks in FrameMaker
that do not have an equivalent in Flare. In cases such as these, the formats
are preserved after conversion to Flare. However, the formats may therefore appear to be broken, but they are preserved to let you know that there
was some formatting in a cross-reference style that Flare did not understand; you can then make changes to the cross-reference style in the
stylesheet. Therefore, if you already know ahead of time that you have a
cross-reference style that will need to be modified for use in Flare, you can
use the Conversion Styles button and change the cross-reference format
to something that Flare understands.
12. Do one of the following, depending on the part of the interface you are using:
n

Wizard Click Next.

n

Import Editor Select the Paragraph Styles tab.

13. Use this page to map paragraph styles from the FrameMaker documents to Flare's paragraph
styles, including those from the stylesheet you may have selected. Your FrameMaker style
will adopt the name of that style. To map a style, click the style in the FrameMaker Styles
column on the left, click a style in the Flare Styles section on the far right, and then click the
Map button. If you previously elected not to preserve the FrameMaker styles, it is recommended that you map to a standard CSS parent style—e.g., map your first-level heading style
to h1, not to h1.(FrameMaker Style).
The style is added to the Flare Styles column. When you are finished importing the documents
and the new Flare project is loaded, the content that had been associated with the style in the
FrameMaker document will now be associated with a new style that you mapped it to.
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EXAMPLE—PRESERVE STYLES
Let's say you have a style in your FrameMaker source document called "Heading1" that is using Arial 14 pt and is red, like this.

Hello
During the process of importing your FrameMaker document using the Import
FrameMaker Wizard, you select the option to preserve your FrameMaker styles.
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The next page of the wizard looks something like this:

When you finish importing, the content that was associated with Heading1 in the
source document is still using Arial 14 pt and is red, just like it was before in
FrameMaker. However, the style is now called "h1.Heading1." In the world of cascading style sheets (CSS)—which is what Flare uses for controlling the look of
content—you've created a class of the h1 style (h1 is the standard style for firstlevel headings). But because you wanted to keep the look of the FrameMaker
style, Flare added it as a child under its parent, h1.
If you make any future changes in Flare to the h1 style, they will trickle down to
the h1.Heading1 child (unless the child style has explicit settings that conflict
with the parent). You can also apply style properties directly to the h1.Heading1
child. So while it is generally a good idea to use standard CSS parent styles (such
as h1) when possible in Flare, the mapping performed in this import process—and
the subsequent creation of a child style—lets you keep the Arial 14 pt red look.
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EXAMPLE—DO NOT PRESERVE STYLES
Let's say you have a style in your FrameMaker source document called "Heading1" that is using Arial 14 pt and is red, like this.

Hello
During the process of importing your FrameMaker document using the Import
FrameMaker Wizard, you select the option to not preserve your FrameMaker
styles.
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The next page of the wizard looks something like this.

When you finish importing, the content that was associated with Heading1 in the
source document is no longer using Arial 14 pt, red. Instead, it looks something
like this.

Hello
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Also, the style is now called "h1." (Keep in mind that, even if you had mapped the
style to "h1.(FrameMaker Style) in this case, the formatting would still be
removed.)
So although the formatting was not retained, you were able to map to the standard CSS style for first-level headings—h1 .
14. Do one of the following, depending on the part of the interface you are using:
n

Wizard Click Next.

n

Import Editor Select the Character Styles tab.

15. Use this page to map character styles from the source documents to Flare's character styles,
including those from the stylesheet you may have selected. Your FrameMaker style will adopt
the name of that style. This works the same as the feature for mapping paragraph styles,
except it has to do with character-level styles. To map a style, click the style in the
FrameMaker Style column, click a style in the Flare Styles section, and then click the Map button.
The style is added to the Flare Styles column. When you are finished importing the documents
and the new Flare project is loaded, the content that had been associated with the style in the
FrameMaker document will now be associated with a new style that you mapped it to.
16. Do one of the following, depending on the part of the interface you are using:
n

Wizard Click Next.

n

Import Editor Select the Cross-Reference Styles tab.
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17. Use this page to map cross-reference (x-ref) styles from the FrameMaker documents to
Flare's cross-reference styles, including those from the stylesheet you may have selected. In
this way, you can have your FrameMaker style take on the appearance of the Flare style that
you map it to. To map a style, click the style in the FrameMaker Style column on the left, click
a style in the Flare Styles section on the far right, and then click the Map button.
The style is added to the Flare Style column. When you are finished importing the documents
and the new Flare project is loaded, the content that had been associated with the
FrameMaker style in the FrameMaker document will now be associated with a new style that
has the appearance of the style that you mapped it to.
What happens if you do not map a style? In the case of cross-reference styles, they are automatically added as style classes under the MadCap|xref style. For example, let's say you
import a style called "PageOnly" from your source document and do not map it to anything. In
that case, it will be called "MadCap|xref.PageOnly" in the resulting project.
18. Do one of the following, depending on the part of the interface you are using:
n

Wizard Click Finish. The Accept Imported Documents dialog opens. The files that will be
created as a result of the import are listed on the left. A preview of each file can be seen
to the right when you click the file.

n

Import Editor In the local toolbar click Import (if this is the first time importing files) or
Reimport (if files have been imported previously). The Accept Imported Documents dialog opens. The files that will be created as a result of the import are listed on the left. A
preview of each file can be seen to the right when you click the file.

19. When you are finished previewing the files to be created, click Accept.

NOTE: You must have FrameMaker installed on your computer in order to import
FrameMaker files.

NOTE: For each master page used in your FrameMaker documents, a corresponding page
layout is automatically created in your Flare project. You can use the page layouts to configure pages for print-based output. You can then create chapter breaks for your printbased output and assign these page layouts to the different topics in the output.

NOTE: Flare supports FrameMaker 7.0 and newer versions.
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NOTE: A link icon displays on tabs in the XML Editor next to file names that are imported
from and linked to another file or Flare project. However, if you are also using the built-in
source control technology, the source control icons have a higher precedence and will
therefore be displayed instead.
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CHAPTER 6

After You Import
After you clean up your source files and import into Flare, you may need to clean up or re-create certain elements.
This chapter discusses the following:
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Set Up Your Master Pages (Page Layouts)
Master pages from FrameMaker are not converted in Flare. You need to re-create them as page layouts. The good news is that page layouts are more flexible than master pages in FrameMaker. For
example, FrameMaker master pages do not allow different sized pages in the same file.
Flare lets you have many pages defined in page layouts, and they can be different sizes. For
example, this allows you to have an 8 x 11 page layout that includes an 11 x 14 page, which allows
for the fold-out schematic that you need in the middle of a chapter.
You can also have multiple sets of page layouts, something that FrameMaker does not allow. This
lets you define one set of page layouts for the 8 x 11 PDF book that you put on your website for customers to download. You can also define 7 x 9 page layouts for the book you will send to the printer
that needs to fit in the product box.

Reference Pages
There are no equivalents to reference pages in Flare. The formatting and other tasks you are used
to performing are done in the Stylesheet Editor, the Page Layout Editor, or both.
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Organize Your Files
After you import, any graphics in your FrameMaker files are put in the same folder as your converted FrameMaker files. This looks messy and probably isn't what you wanted. You can easily fix
this.
In the Content Explorer, click the Show Files button

.

After you click the Show Files button, a two-pane view opens. You can expand your folders or create
a new folder by clicking the New Folder button
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On the right side, select one or more files you want to move. Drag them to the folder on the left
where you want to store them. The Resources\Images folder is the default location for new images
that you create in Flare, so you may want to drag all of your graphic files to that folder (you may
need to manually create the "Images" subfolder first). All of the standard Windows multi-select
options are available.

You are prompted to update links when the files are moved. Make sure you click Update so that
Flare knows where these files have been moved to and how to find them.
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Move and Resize Your Graphics
Your graphics came through but, as with any conversion, there will be some tweaking to get them
placed exactly where you want them, especially if your graphics were in the left margins in
FrameMaker.
There are no anchored frames in Flare. To select a graphic, right-click it and choose Select. You can
also right-click the image and select Image Properties to format and position the graphic the way
you want it; you can also right-click and use the Text Wrap context menu and position images absolutely by dragging them around. For more information see the topics "Using Floats for Positioning
Elements" and "Using Absolute Positioining on Elements" in the online Help.

Reuse Your Stylesheet in the Next Project
The next time you need to import another FrameMaker project, all the time and work you put into
perfecting your stylesheet will pay off.
During your next import process, browse and select the stylesheet you already like. This reduces all
the effort in defining and mapping styles. All you have to do is map styles and account for any new
FrameMaker formats not mapped or created in your stylesheet.
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Reuse Your Import File
When you finish importing FrameMaker documents, an import file is created and stored in the Project Organizer in Flare. This file contains all of the settings ("rules") that you entered in the Import
FrameMaker Wizard when you imported the documents. If you need to re-import the files, you can
simply open this file so that you don't have to redo all of your settings. You can also make copies of
this file and tweak it for importing other FrameMaker books and files (i.e., remove selected files
from the Source Files list and add other files that you want to import with the same rules).

Now What?
Now that you've completed the first step (creating a project), you can add more topics, create snippets, develop tables of contents, edit targets, and work your way through all of the other steps that
are part of producing online and/or print-based output.
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CHAPTER 7

FAQs for FrameMaker Users
Following are some frequently asked questions for FrameMaker users transitioning to Flare.
This chapter discusses the following:
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Where is the Book File from the Adobe
FrameMaker Documents?
There is no comparable BOOK file in Flare. The Import FrameMaker Wizard converts the Adobe
FrameMaker BOOK file and other documents to topic files and places them in a folder in the Content Explorer named for the imported Adobe FrameMaker BOOK file.
EXAMPLE
Let's say you imported a FrameMaker BOOK file called "Getting Started Guide." Following the import, you can locate the converted content of that BOOK file in a folder
named "Getting Started Guide" within the Content Explorer.
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What is a Stylesheet and Why Do I Need
One?
One feature of Flare that may be new for some Adobe FrameMaker users is the concept of
stylesheets. It is important to understand the critical role that stylesheets play in Flare.
Stylesheets are simply a collection of formatting rules that control the appearance of content in output. In Flare, all paragraph styles and character styles are contained in a stylesheet. A stylesheet
completely replaces the Paragraph Designer, Character Designer, and Catalogs in Adobe
FrameMaker.
Stylesheets let you separate content from presentation. This makes it much easier to control a
standard appearance for all of your content because you don’t need to update every page when you
want to make a change. A stylesheet gives you flexibility and control over the exact appearance of
your content. With stylesheets you can control many properties, including specific fonts and font
sizes; bold, italics, and underlining; text and background color; link color and underlining; and much
more. By using stylesheets to control the look of your content, you can ensure a consistent appearance in the output.
Most importantly, a stylesheet satisfies all the formatting requirements of a Flare project and
removes the task of importing paragraph and character styles from other Adobe FrameMaker documents. A change or update to a style is automatically reflected in all places where that style is
used.
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What Happened to My Paragraph and
Character Styles?
In Adobe FrameMaker, you used the Character Designer, Paragraph Designer, and Catalogs to manage your text formatting needs. When you import Adobe FrameMaker documents, all the style
information is placed in a stylesheet, which can be viewed in Flare's Stylesheet Editor.
In addition to the styles you created in Adobe FrameMaker, you will notice many more styles that
Flare adds. These styles are adopted from W3C specifications (see http://www.w3c.org), or they
are MadCap-specific styles used to support unique features in Flare.
1. Open the Content Explorer.
2. Navigate to your stylesheet.
NOTE: When you add new stylesheets (not import them), the traditional default location for those stylesheets is within the Resources folder (although they can also be
placed in custom folders). To open a stylesheet from this location, double-click the
Resources folder. Then double-click the Stylesheets folder.
3. Double-click the stylesheet. The Stylesheet Editor opens.
4. In the Stylesheet Editor, your imported paragraph and character styles can be found in the following locations, depending on your selections in the Import FrameMaker Wizard.
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PARAGRAPH STYLES
If you imported paragraph styles without mapping them to Flare styles, they can be found
under the p style in the Stylesheet Editor.
EXAMPLE
If you imported a paragraph style called "Chapter," you can find it under the p
style, and its new full name is "p.Chapter."

Please note that this example is showing the Advanced view of the Stylesheet
Editor. You can also work in the Simplified view of the editor, which shows the
styles in a grid.
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CHARACTER STYLES
If you imported character styles without mapping any of them to existing Flare styles, your
character styles can be found under the span style.
EXAMPLE
If you imported a character style called "Emphasis," you can find it under the
span style, and its new full name is "span.Emphasis."
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MAPPED STYLES
If you imported paragraph and character styles, mapping them to existing Flare styles, they
will be found under the tags that you mapped them to.
EXAMPLE
If you imported a paragraph style called "Chapter" and mapped it to the Flare
style called "h1," you can find the imported style under the h1 style, and its new
full name is "h1.Chapter."

EXAMPLE
If you imported a character style called "Emphasis" and mapped it to the Flare
style called "b," you can find it under the b style, and its new full name is "b.Emphasis."
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Why Does the User Interface Look So
Different from Adobe FrameMaker?
There are significant differences between the Adobe FrameMaker and Flare user interfaces.
In Adobe FrameMaker, a window appears when you open a document. The window shows the document laid out in a page design with text, images, and other elements in their places. You can customize the interface slightly by displaying window guides such as borders, text symbols, rulers, and
grids.
Adobe FrameMaker was developed in the late 1970s, while Flare is much more modern looking and
is designed to support the future of single-source publishing.
Unlike the Adobe FrameMaker interface, which presents a traditional page analog for text entry with
pull-down menus for additional options, Flare features a visual XML editor, driven by cascading
stylesheets.
Editors are available for every Flare project element and can be arranged as tabs or accordion
items; docked or floating. You can open and work in multiple windows to suit your preferences.
Visual indicators of conditions, variables, and index markers speed your development process.
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Is There a Master Page and What Does It
Do?
In Flare you can use master pages or page layouts.
A master page is an element that you can create in your project in order to apply certain content to
multiple topics. A master page is primarily used in online outputs, but it can be used in Word output
as well. Depending on the output type, you might use a master page in online output to apply features such as breadcrumbs, menus, toolbars, search bars, mini-TOCs, or footer text to multiple topics, or even all topics in a target. For Word output, a master page allows you to determine page
specifications (such as size or orientation) and to apply certain content (such as header text or
page numbers) to many topics in a manual. For print-based outputs other than Word, page layouts
are used instead of master pages.
Page layouts are similar to master pages, but are more flexible and easier to use. The general rule of
thumb is that page layouts are recommended for print-based output (when possible), and master
pages continue to be the best method for automatically adding headers, footers, and breadcrumbs
in multiple topics for online output. Another difference between page layouts and master pages is
that page layouts can be used for any of the print-based outputs (Adobe PDF, Microsoft Word),
whereas master pages can be used only for Microsoft Word when creating print-based output.
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What About Third-Party Tools That I
Depended On to Enhance Adobe
FrameMaker?
Much of the add-on functionality that you depend on in Adobe FrameMaker is supplied by the analysis feature in Flare. The project analysis can scan your topics and make suggestions for missing
variables, broken links, missing images, and many other analytical tasks. Then with a few clicks of
your mouse, you can correct the issues that were identified through project analysis.
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Where are the Images I Imported with the
FrameMaker Files?
The Import FrameMaker Wizard copies the imported images to a folder in the Content Explorer
named for the imported Adobe FrameMaker BOOK or other files. If you prefer, you can move the
images to a folder within the Resources folder. The Resources\Images folder is the default location
for new images that you create in Flare.
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APPENDIX

PDFs
The following PDFs are available for download from the online Help.
TUTORIALS

Getting Started Tutorial
Product Foldout Tutorial
Side Navigation Tutorial
Top Navigation Tutorial
USER GUIDES

Accessibility Guide

HTML Help Guide

Analysis and Reports Guide

HTML5 Guide

Architecture Guide

Images Guide

Autonumbers Guide

Importing Guide

Condition Tags Guide

Index Guide

Context-sensitive Help Guide

Key Features Guide

Eclipse Help Guide

Language Support Guide

Getting Started Guide

MadCap Central Integration Guide

Global Project Linking Guide

Master Pages Guide
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Micro Content Guide

Source Control Guide: Git

Movies Guide

Source Control Guide: Perforce

Navigation Links Guide

Source Control Guide: Subversion

Plug-In API Guide

Source Control Guide: Team Foundation Server

Print-based Output Guide

Styles Guide

Project Creation Guide

Tables Guide

Pulse Guide

Tables of Contents Guide

QR Codes Guide

Targets Guide

Reports Guide

Templates Guide

Reviews & Contributions Guide

Topics Guide

Search Guide

Touring the Workspace Guide

SharePoint Guide

Transition From FrameMaker Guide

Skins Guide

Variables Guide

Snippets Guide

What's New Guide

CHEAT SHEETS

Folders and Files Cheat Sheet
Print Output Cheat Sheet
Shortcuts Cheat Sheet
Structure Bars Cheat Sheet
Styles Cheat Sheet
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